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Ableton Live 
Create, produce and perform music within one intuitive interface. Live keeps everything in sync 
and works in real-time, so you can play and modify your musical ideas without interrupting the 
creative flow. 
Notes based on The Ableton Live reference manual 

 

First Steps 

Settings 

Settings can be found in the Options menu on Windows and in the Live menu on macOS or 
shortcut C m d / C t r l  ,  
 
Things you might need or want to change: 
Display & Input 
 Zoom 
 Follow behavior: Scroll or Page  

Theme & Colors 
Audio 
 Driver type: Core audio (Mac) / ASIO (PC) 
 I/O devices 
 Sample Rate: 48000 or 44100 Hz 
 Buffer size: 256 samples is fine for most cases 

Smaller sizes might be needed for live recording (audio and midi) as it gives you less latency. 
Bigger buffer sizes can be used when mixing as it makes your computer more efficient. You can 
notice pops and clicks when using really small buffer sizes. 
 
🎬 Learn Live: Setting your Preferences 
🎬 Learn Live: Setting up an audio interface 
 

New Live Set  
c m d /c t r l  N  

 A project in Live is called a Set.  
 A new set always opens in Session view. You can change this by making a new Default Set  

 

Save 
c m d /c t r l  S  

 Live makes a project folder containing the file with an .als file (acronym of Ableton Live 
Set) 

 Saving does not stop playback 
 ‘Collect all and Save’ is second option to save. With this command (under file) you collect 

all samples and presets and save them in the project folder. 
 
🎬 Learn Live: Saving Projects 
 
 

https://www.ableton.com/en/live-manual/12/welcome-to-live/
https://www.ableton.com/en/live-manual/12/first-steps/#lives-settings
https://www.youtube.com/watch?v=TwQC9EU2BYE
https://www.youtube.com/watch?v=D9tjzSctp_Q
https://www.ableton.com/en/live-manual/12/live-concepts/#live-sets
https://www.youtube.com/watch?v=M6lIz4Fyc2w
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Exporting 

The Export Audio/Video command in the File menu or S h i f t  c md /c t r l  R  lets you export Live's audio 
output as a new sound file.  
 
 Render Start: Sets where rendering begins. 
 Render Length: Determines the duration of the rendered sample. 
 To quickly set both values, select a time range by positioning the loop brace in [AV] before 

using the export command.  
 Keep in mind that the rendered audio file will capture everything you hear before 

rendering, regardless of which view is active.  
 It is also good practice to leave some extra space after to composition to leave room for 

reverb and delay tails. 
 
🎬 Learn Live: Exporting 
 

UI overview 

     Learn Live 12: Live’s user interface 
 

Info view  

The Info View is situated in the bottom left corner. Open in view menu if closed or use ?  key. 
Hover over elements and get information about the function.  
 

Control bar  

The Control Bar stays always visible no matter what you do. 
 
Metronome And Tempo Settings  
 Tempo in BPM (or Beats Per Minute) 
 the Time Signature (maatsoort in Nl) provides information about the rhythm. It indicates 

how many notes fit into a measure (top number), and which note is the counting unit 
(bottom number). Commonly used time signatures are 4/4 and 3/4. 

 metronome  
Scale 
Transport 
 follow on/off to follow the position  (2 options scroll / page in settings) 
 arrangement position 
 transport controls: play, stop, record 

s p a c e b a r  toggle play / stop 
s h i f t  s p a c e  continues from stop 
o p t /a l t  s p a c e  play arrangement selection 
 

     Learn Live: Transport bar and Follow behavior 
 
loop  
 punch switches 
 loop switch (only for arrangement) 

midi 
 draw mode  

https://www.ableton.com/en/live-manual/12/managing-files-and-sets/#exporting-audio-and-video
https://www.youtube.com/watch?v=JTtSihQ8QX0
https://www.youtube.com/watch?v=_XDkA_f8n08
https://www.ableton.com/en/live-manual/12/first-steps/#using-the-info-view
https://www.youtube.com/watch?v=m84wUU8CQnY
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 computer midi keyboard (see addendum at bottom) 
 key & midi mapping 
 cpu 

 

Browser 

Open & close with o p t /a l t  c m d /c t r l  b  or o p t /a l t  c m d /c t r l  5  
 
The Browser is divided in a sidebar & content pane 
Sidebar is again divided in 3 sections: Collections, Library, Places 
Library 
 All 
 Sounds: virtual instrument presets 
 Drums: drum presets, loops & oneshots (kicks, snare, hihats, …) 
 Instruments: included virtual instruments available in the Live version you use (intro, suite, 

…)  
Clicking an instrument shows a folder icon. The folder is a default preset. Opening the folder 
shows all different presets made with that same device. You can audition an instrument. 

 Audio Effects: included audio effects that come with Live 
 Midi Effects 
 Modulators 
 (Max for Live) 
 Plug-Ins: 3rd party devices (VST plugins / audio units) 
 Clips: audio & midi clips 
 Samples: audio files (wav & aif only) 
 Grooves: files that enable us to quantize audio or midi data 
 Tunings 
 Templates 

Places 
 Packs are extensions for Live and can be samples, devices, effects etc 
 Add folder 

 
🎬 Learn Live 12: Live’s Browser 

Session View & Arrangement View  

2 different workflows   
The Session is a real-time-oriented “launching base” for Clips.  
The Arrangement is a layout of clips along a musical and linear timeline.  
 
t a b  key to switches between both 
o p t /a l t  1 ( & )  opens Session View [SV] 
o p t /a l t  2 ( é )  opens Arrangement View [AV]  
 
Arrangement and Session are connected via Tracks. 
 
Tracks 
In [SV] tracks are laid out in columns. Tracks contain clips (or placeholders for clips). A track can 
only play one clip at a time. You want to spread out clips that should play together across tracks 
in rows. We call this Scenes. 
 
In [AV] tracks are horizontal bars that are stacked vertically, with time moving from left to right.  
 

https://www.youtube.com/watch?v=KcmPBZTwq78
https://www.ableton.com/en/live-manual/12/live-concepts/#arrangement-and-session
https://www.ableton.com/en/live-manual/12/live-concepts/#arrangement-and-session
https://www.ableton.com/en/live-manual/12/live-concepts/#tracks
https://www.ableton.com/en/live-manual/12/session-view/#tracks-and-scenes


Ableton Page 4 10/10/2024 

Swapping the views changes the appearance of the Set but does not switch modes. If you work 
in both [SV] & [AV] clips cannot play in both modes. When a Session clip is launched, the 
respective track stops whatever it is doing to play that clip. If you want to play the clip in [AV] you 
need to press the Back to Arrangement Button or Single Track’s Back to Arrangement Button.  
  
🎬 Learn Live: Tracks 
 
Clips  
Clips are the pieces of musical material. These can be sound file or midi based. 
 
Audio signals are recorded and played back using audio tracks. 
MIDI signals are recorded and played back using MIDI tracks.  
 
 

Clip View 

Clip View is where clip properties can be set and adjusted. 
double-clicking a clip in either [SV] or [AV] opens the Clip View pane. 
o p t /a l t  c m d /c t r l  3 ( " )   
 

Device View 

A track can contain not only clips but also a chain of devices for processing signals.  
Double-clicking a track’s title bar in [SV] brings up the Device View. In [AV] you need open use 
the Device View Selector toggle at the bottom or use the shortcut o p t /a l t  c m d /c t r l  4 ( ' )   
 
Try to click on title of the return tracks to open the reverb & Delay devices. 
 
🎬 Learn Live: Detail View 
 

Mixer 

After the signal has passed through the device chain, it ends up in the mixer.  
As the Session and Arrangement share the same set of tracks, they also share the mixer. It can 
be shown in both views for convenience. 
o p t /a l t  c m d /c t r l  m  to show & hide the mixer 
 
It has controls for: 
 Routing: audio in, out & monitor settings 
 Volume 
 Pan 
 Sends: adjust the amount it inputs to a return track (labeled A & B). Return tracks only host 

effects, not clips. 
 Mute  
 Solo 
 Arm Recording: enable recording 

The possibility to have the Mixer available in [AV] is new since Live12. 
 
🎬 Learn Live: Live's Mixer 
 
Tip: there is a lot going on in the user interface. It is key to make space opening and closing parts 
of the UI when you work on a smaller screen. Doing so with shortcuts will make your time with 
Live easier. 

https://www.youtube.com/watch?v=nFFYXMEG7NE
https://www.ableton.com/en/live-manual/12/live-concepts/#audio-and-midi
https://www.ableton.com/en/live-manual/12/clip-view/#clip-view
https://www.ableton.com/en/live-manual/12/clip-view/#clip-view
https://www.ableton.com/en/live-manual/12/working-with-instruments-and-effects/#working-with-instruments-and-effects
https://www.ableton.com/en/live-manual/12/live-concepts/#devices-and-the-mixer
https://www.youtube.com/watch?v=qCFsda-XTSg
https://www.ableton.com/en/live-manual/12/mixing/#the-live-mixer
https://www.youtube.com/watch?v=P1Y1FEcw2xQ
https://www.ableton.com/en/live-manual/12/live-keyboard-shortcuts/#live-keyboard-shortcuts
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🎬 Learn Live: Basic keyboard shortcuts 
 
 

ARRANGEMENTS 

 
Arrangement is the process of taking a rough collection of musical ideas, sounds, loops, and 
parts and structuring them into a finished piece (of music, sound, score, …). We will work in 
Arrangement View to combine and arrange different elements of sound on a linear timeline.  
 

Arrangement View UI overview 

 
🎬 Learn Live: Arrangement View 
 
Upper Area 
 Overview: displays the entire arrangement layout, used for zooming and navigation  
 Beat-time Ruler: displays time in bars-beats-sixteenths 
 Loop region 
 Scrub Area click start playback from that point 
 Locators etc 

 
Main Area: the Tracks 
 Contain the clips 
 Volume, panning, I/O, etc are available via the Track Controls.  

Customizable using the Arrangement Track Controls submenu in the View menu. 
 Reordering by dragging 
 Renaming c m d /c t r l  R  & coloring 
 Add new tracks: audio cm d /c t r l  T  / midi s h i f t  cm d /c t r l  T  
 Optimize Height H and Width W toggles & shortcuts H  & W  

time ruler 
 Completely at the bottom of the [AV] area 
 time is displayed in minutes-seconds-milliseconds 
 click and drag in the time ruler to scroll left or right 

Mixer 
 

Transport & Playback 

Play/Stop playback   
buttons in the control bar or press s p a c e  to toggle playback, or s h i f t  s p a c e  to continue from stop, 
or o p t /a l t  s p a c e  to play an arrangement selection (once). 
 
flashing blue insert marker  
 determines where playback starts 
 by default, this is at the start of the Arrangement 
 click anywhere within a track to move the insert marker and set a new play position 
 double-click the Stop button to return the insert marker to start 

loop  

https://www.youtube.com/watch?v=1hSPWWRIIbg
https://www.ableton.com/en/live-manual/12/arrangement-view/#arrangement-view
https://www.youtube.com/watch?v=riOD-fnyCsg
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 activate the Arrangement Loop using the Loop Switch toggle in the Control Bar or press 
c m d /c t r l  L  

 set the loop brace in the loop region 
 use up, down, left & right keyboard arrows to move the loop 
 use cmd/ctrl left / right to shorten or lengthen the loop 
 use cmd/ctrl L to set a loop to a selection (e.g. selected clip) 

 
Navigation & Zooming 
 
 Zoom in & out by hovering the mouse over the Beat Ruler, the cursor becomes a 

magnifying glass, drag up & down to zoom, and left & right to pan. 
 Or zoom in & out with +  & -  keys or mouse scrolling / trackpad pinching 
 Zoom to a selection with Z  key 
 Zoom to Arrangement Time Selection previous zoom state with X  key  

Note that when zooming in multiple times using the Z  key, the X  key can be pressed 
multiple times to go back one step each time the key is pressed. 

 Remember that you can also use the optimize Height H and Width W toggles & shortcuts H  
& W  

 
Follow 
Follow the song position and scroll automatically, turn on the Follow switch in the Control Bar or 
s h i f t  o p t /a l t  F  
 

Working with Audio Clips 

Drag clips from the Browser to the appropriate tracks. Audio samples go to an Audio Track. Midi 
Sounds, Drums & Instruments go to Midi Tracks. 
 
🎬 Learn Live: Editing clips in Arrangement View  
 
Moving and Resizing 
 drag a clip on the title bar to move it to another position or track 
 drag a clip’s left or right edge (of the title bar) changes the clip’s length. Note! If loop 

switched is on (look for the ‘loop’ button in the main window of clip view) it will loop it if 
you make it longer then its actual length 

 s h i f t  o p t /a l t  to drag a clip content within boundaries 
 
Fades and Crossfades 
 fade controls are at the edges of audio clips (tracks need to be expanded to become 

visible)  
 hover over an audio clip edge to access the fade handles and set fade duration and slope 
 adjacent clips can be crossfaded 
 to delete a fade, select a fade handle and press the delete key 

 
Splitting Clips 
 to isolate certain areas of one clip into its own separate clip you can slit it  
 click anywhere within a clip’s waveform and press cmd/ctrl E to divide the clip at that 

location 
 
Consolidating Clips 
 consolidating clips is a good way to join material from several clips into a new loop  

https://www.youtube.com/watch?v=xdwZpIpN6ys
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 press c m d /c t r l  J  to combine selected clips into one new clip 
 consolidated clips are stored in the current project folder 

 
Optional: Check out the reverse option. 
 
🎬 Learn Live: Arrangement View shortcuts 

 

Tempo & Warping 

Audio in Live can be stretched and manipulated creatively through warping. It is essentially 
about two core processes: time-stretching and pitch-shifting. Time-stretching allows you to 
alter the tempo of a piece of audio without affecting its pitch, while pitch-shifting enables you to 
change the pitch without altering the tempo. 
It allows seamless beat matching, rhythmic experimentation, and sound design but also track 
synchronization during playback and live performances. 
 
🎬 Learn Live: Warping clips 
 
Warp on / off  
 first let’s decide on the playback tempo of our Set in the Control Bar’s tempo field 
 then warping properties are located in the Clip View’s Audio tab/panel 
 the warp switch toggles warping on or off 
 try to change the tempo now 

 
Turn Warp on to synchronize rhythmically structured samples, such as loops or entire songs, 
with the Set’s tempo. 
With Warp off, the sample plays at its original tempo, unaffected by the Set’s tempo. This is 
ideal for non-rhythmic samples like one-shots, textures, sound effects, or spoken word. 
 
Stretch a clip 
Alternatively, if you don’t want to work with tempo changes you can also compress (shorten) or 
stretch (lengthen) an audio clip by shift drag it from its edges (again of course with warp 
switched on). 
 
Warp Modes 
There are 6 Warp Modes or algorithms, each designed to handle specific types of audio 
material: 
 Beats Mode: best for rhythmic sounds, preserving punch and clarity in drums 
 Tones Mode: ideal for monophonic sounds like vocals, using granular synthesis for smooth 

time-stretching while keeping pitch 
 Texture Mode: suited for polyphonic or complex sounds, offering control over grain size for 

experimental manipulation. 
 Re-Pitch Mode: Links tempo and pitch, speeding up increases pitch, slowing down lowers 

it, like analog tape. 
 Complex/Pro Modes: Advanced modes for full mixes, offering transparent time-stretching 

and pitch-shifting. 
 
Optional: Warp Markers 
Warp Markers let you lock specific points, generally transients, in a sample to the timeline. They 
can map the audio's timing or change its rhythm. While initial markers are added when a sample 
is imported, you can manually add more or delete others as needed. 

https://www.youtube.com/watch?v=WW_DnCnEggA
https://www.ableton.com/en/live-manual/12/audio-clips-tempo-and-warping/#warping
https://www.youtube.com/watch?v=tlsRVC72hx4
https://www.ableton.com/en/live-manual/12/clip-view/#the-audio-tabpanel
https://www.ableton.com/en/live-manual/12/audio-clips-tempo-and-warping/#warp-modes
https://www.ableton.com/en/live-manual/12/audio-clips-tempo-and-warping/#warp-markers
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They are represented as yellow markers at the top of the Sample Editor. 
 
 add a Warp Marker at a place in time by double-clicking in the upper half of the Sample 

Editor (or cmd/ctrl I at current location / blue insert marker) 
 moved Warp Markers with the arrow keys or drag them to different points in time  
 with a Warp Marker selected, hold shift to drag and move the waveform, allowing precise 

adjustment of the audio's starting point under the marker 
 double-click the markers to delete them 

 
Transients or Pseudo-Warp Markers 
When you load a sample into a track, Live automatically detects transients, which are 
amplitude peaks marking the start of notes or beats. These are ideal spots for placing Warp 
Markers. 
 
Transients are represented by small grey markers at the top of the Sample Editor. They are 
stored in a separate .asd file.  
 
Optional: 🎬 Learn Live: Warping in Simpler 
 

Audio Effects 

Audio effects act on audio signals and can be added on an audio tracks or midi tracks (if 
placed after an instrument). We have already experimented with 2 audio effects in working 
with the return tracks: reverb & delay.  
There are many more accessible in the browser under Audio Effects. 
 

How to use them 
 drag an audio effect device onto a track or drop area into the Device View  
 try adding a second effect and deleting it again 
 signals in a device chain always travel from left to right. The order of effects determines 

the resulting sound. 
 devices are turned on and off using their Activator switches 
 have input and output level meters 
 hot swapping presets. Presets are stored parameter settings. 

 
Main Audio Effects 
Check them all in the reference 

Channel EQ  
 a versatile and classic three-band Equalizer  
 low (100 Hz), mid (120 Hz to 7.5 kHz) and high (10 Khz) parameter to boost or attenuate the 

frequencies 
 it also features a 80hz high-pass filter useful for removing the rumble from a signal 
🎬 Learn Live: Channel EQ 

Compressor  

Delay 
🎬 Learn Live: Delay 

https://www.youtube.com/watch?v=1I59CN7NKIg
https://www.ableton.com/en/live-manual/12/working-with-instruments-and-effects/#working-with-instruments-and-effects
https://www.ableton.com/en/live-manual/12/live-audio-effect-reference/#live-audio-effect-reference
https://www.ableton.com/en/live-manual/12/live-audio-effect-reference/#channel-eq
https://www.youtube.com/watch?v=aAwpVte261Y
https://www.youtube.com/watch?v=Ss5yOq8nQK4
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Limiter 

Reverb 

Auto pan  
 an LFO-driven panning & amplitude automation 
 useful for tremolo and amplitude  

Chorus Ensemble 
🎬 Learn Live: Chorus-Ensemble 
 
 

Automation & Envelopes 

When working with the mixer and devices, you may want control values that change over time. 
Think about a long fade out, a sudden volume burst, panning a sound from left to right and back, 
… This is called Automation and Editing Envelopes. Almost all mixer and device controls, 
including tempo, can be automated in Live. 
 
🎬 Learn Live: Arrangement View automation 
 
In [AV] automation can be edited as breakpoint envelopes (besides recording it). 
 Click the toggle button above the track headers or press A  to enable Automation Mode (& 

show automation envelopes)  
 Clicking on a track's mixer or device controls will display the corresponding envelope on 

the clip track 
 
Envelopes appear in the main automation lane, overlaying the audio waveform, allowing you to 
align breakpoints with the content. The vertical axis represents the control value, while the 
horizontal axis represents time. For switches and radio buttons, the value axis is on or off. 
 
 The Device chooser lets you select the track mixer, a device, or ‘None’ to hide the envelope  
 Selecting one also indicates which devices have automation with an LED next to their 

labels  
 The Automation Control chooser allows you to select a control from the chosen device, 

with automated controls indicated by an LED 
 
Once an envelope is selected on the track, several new buttons appear: 
 +  add Automation Lane button moves the envelope to its own lane below the clip, allowing 

you to view another automation parameter simultaneously. This button is hidden if set to 
‘None’ 

 -  remove Automation Lane button hides the respective lane but does not deactivate its 
envelope  

  Toggle Additional Automation Lanes allows you to show / hide all additional lanes 
 
Right-clicking in the Track Title Section opens a context menu with options for viewing 
envelopes and commands to:  
 quickly clear specific or all automation envelopes for the track 
 add lane for each automated envelope 

 
With Draw Mode enabled, you can click and drag to draw an envelope curve. I prefer to draw 
envelopes with breakpoints & line segments (thus not in draw mode). 
 Double click in an Automation Lane (near the dashed red line) to create a new breakpoint. 
 Click on a breakpoint to remove it 

https://www.ableton.com/en/live-manual/12/live-audio-effect-reference/#auto-pan
https://www.youtube.com/watch?v=25Uiav5UA9c
https://www.ableton.com/en/live-manual/12/automation-and-editing-envelopes/#automation-and-editing-envelopes
https://www.youtube.com/watch?v=DPBN34nQ_v4
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 Drag a breakpoint to move it to the desired position 
 Click a line segment to select and drag it 
 Hold o p t /a l t  and drag to curve a segment. Double-click while holding o p t /a l t  to revert to a 

straight line. 
 
 
 

OTHER LEARNING RESOURCES 

 
Ableton Live 12 Essential Training video tutorials door Rick Schmunk op Linkedin Learning. 
 
Ableton Live Explained in 37 minutes  
 
Ableton Music basics & learning synths 
 
Ableton Tutorial: Four ways to use field recordings by Nicholas Thayer on YT 
Processing 'Elements' Field Recordings & Layering Field Recordings on modeaudio.com 
 
 
 

EXTRA’S 

COMPUTER MIDI KEYBOARD LAYOUT 
 

 

https://www.linkedin.com/learning/ableton-live-12-essential-training/learn-the-essentials-of-ableton-live-12?resume=false&u=121303466
https://www.youtube.com/watch?v=8NfnRShtIFE&t=203s
https://learningmusic.ableton.com/
https://learningsynths.ableton.com/
https://www.youtube.com/watch?app=desktop&v=5igxT3Dwpt4
https://modeaudio.com/magazine/processing-elements-field-recordings
https://modeaudio.com/magazine/production-tips-using-elements-field-recordings-in-mixes
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